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Basic Printing

Basic Printing

Note This Quick Start Guide describes some of the features of your i9100
printer and how to use them. For more information, view the /9700
User's Guide on the Setup Software & User's Guide CD-ROM, or use the
online help within your printer driver interface:

(Windows|

While in the printer's Properties window press the F1 key, or click ? in
the upperright corner. Then click the feature you want to know more
about, or click the Help button when displayed.

Turn Balloon Help on by selecting Help, then Show Balloon Help.

Turning on the Printer

1 Pressthe POWER button.

The POWER lamp flashes while the printer is warming up, and changes to steady
(non-flashing) green when the printer is ready.

Note |fthe POWER lamp changes to orange and begins flashing, refer to the
section "Handling Error Messages" on page 55.
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Loading Paper

B Print Media to Avoid

Do not use the following types of paper. Using such paper will not only produce
unsatisfactory results, but can also cause the printer to jam or malfunction.

1

Folded, curled or wrinkled paper

Damp paper

Excessively thin paper (less than 64 gsm or 17 Ib)
Excessively thick paper* (more than 105 gsm or 28 lb)
*non-Canon branded paper

Picture postcards

Postcards affixed with photos or stickers
Envelopes with double flaps

Sealed envelopes

Envelopes with an embossed or treated surface
Any type of paper with holes (such as loose-leaf)

Loading the Print Media

This section describes how to load plain paper into your printer.

For detailed information on the specialty media Canon provides for use with its
various printers, refer to the section "Using Specialty Media" on page 6.

Consult the User’s Guidefor detailed instructions on how to load envelopes and

specialty media into the printer.

Flatten the four corners of the paper before loading it.

Important When paper is curled, hold the opposing curled corners and gently bend
them in the opposite direction until the paper becomes completely flat.
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2 Prepare to load paper.

(1) Open the paper rest extension when
printing on paper larger than Letter.

(2) Pull the output tray extension out
one step when printing on Ledger
(11" x 17") size paper or smaller,
and pull it out two steps when
printing on paper larger than
Ledger.

(3) Open the front cover and move the paper thickness lever to the correct position
for the media in use.
Move the lever to the left position for plain paper.
Move the lever to the right position for envelopes and T-Shirt Transfers.
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3 Load the paper.

(1) Insert the paper into the
sheet feeder with the print
side facing up.

(2) Align the paper stack

against the right side of

the sheet feeder.

7

(3) Pinch the
paper guide
and slide it
against the
left side of
the stack of

paper.

Limit Mark

Do not load paper
beyond this Load Limit
Mark.

When Printing is Finished

Note @ Do not stack more than 40 sheets in the paper output tray.
® Do not touch the printed surfaces until the ink dries. For specific
drying times, refer to the instructions packaged with your media.

Using Specialty Media

Canon recommends that you use genuine Canon media to ensure optimal print quality.

B Photo Quality Media B Media Suited for Business
* Photo Paper Pro Documents
* Photo Paper Plus Glossy * High Resolution Paper
¢ Matte Photo Paper ° Transparencies
¢ Glossy Photo Paper
[ ]

High Resolution Paper

Annunl Report | 15

!
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B Canon Specialty Media

Media Type

Paper Rest Load
Limit

Paper Thickness
Lever Position

Printer driver setting

Photo Paper Pro

4" x6":up to 20
sheets

Paper sizes other
than 4" x 6": 1 sheet

Left

Media Type
Photo Paper Pro*

Photo Paper Plus Letter: 1 sheet Left Photo Paper Plus
Glossy 5"x7":upto 10 Glossy

sheets

4" x 6": up to 20

sheets
Matte Photo Paper  |Up to 10 sheets Left Matte Photo Paper
Glossy Photo Paper |1 sheet Left Glossy Photo Paper
High Resolution 11" x 17", Letter: up |Left High Resolution
Paper to 80 sheets Paper

13" x19": up to 20

sheets
T-Shirt Transfers 1 sheet Right T-Shirt Transfer
Transparencies Up to 30 sheets Left Transparency

Note @ Fora detailed description of print media types, refer to the User’s Guide.
® *: Print settings are much easier to select if you use the applications
included on the Setup Software & User's Guide CD-ROMwhen printing on

the Photo Paper Pro (4" x 6").

For instructions on how to print from software applications, refer to the on-
screen Photo Application Guide.
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B Caring for Your Photographs

The Canon i9100 Photo Printer will generate spectacular results for printing
photographs, especially when used with Canon specialty media. All images are
susceptible to fading over time, but proper care of prints made from your i9100 Photo
Printer will ensure that print quality lasts long into the future.

Many environmental factors can impact how long a printout will last before noticeable
image fading occurs. Exposure to sunlight or other light sources, humidity,
temperature, exposure to cigarette smoke and ozone are just some of the factors that
can impact image permanence. While many of these variables cannot be controlled,
there are basic measures that you can take to prolong image quality:

e Use Canon Photo Paper Pro and genuine Canon inks. Canon Photo Paper Pro is
available in A3+ size (13" x 19") and letter size (8 ¥2" x 11"). Canon Photo Paper Pro
for Borderless Printing is available in photo size (4" x 6"). These papers are
specifically designed to work with genuine Canon inks.

e Mount images under glass to reduce exposure to ozone, cigarette smoke and other
environmental factors that can degrade images.

¢ Keep printed images out of direct sunlight or other intense light sources.
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(Windows|
Printing with Windows

Note @ The menu screens and dialog boxes that appear may vary, depending on the
software application you are using.
® The steps described in this section are for printing in Windows XP.

1 cCreate a document, or open a file to print.

2 Open the Printer Properties dialog box.

(1) Select Print from the application software's File menu.
The Print dialog box is displayed.

General |

Select Printer

| e (2) Ensure that the
Add Printer | [S=l ey RiER NN} Canon i9100 is

selected.
Status: Feady [ Prirtt ta filg

Location:

St (3) Click Preferences
Page Range (Or Propel’ties).
@ 8l Mumber of copies:
O Pages
Enter either a zsingle page number or a single Ijl ] I

page range. For example, 512

Frint H Cancel ]

Note InWindows 2000, click the Main tab in the Print dialog box.
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3 Specify the required settings.

& Canon i9100 Printing Preferences,

) Main |3 PageSetup| @) Stamp/Backaground | o# Effects| (3} Profiies | # Maintenance

@[]

“H— (1) Click Media Type to select
E the type of media loaded in

the printer.

Papgr Source:

Fiint Qualty ©

" Custom
Color Adjustment: Ao
_= |
About Defaults
(2) Click OK.

Note @
L]
L]
L]

From the Page Setup tab select the correct document size to be
printed.

To adjust Print Quality settings, select Custom and click Set on the
Main tab. You can control the print quality in the Set Print Quality
dialog box.

For details about other printer driver functions, refer to the User’s
Guide or Help.

Select Preview before printing by clicking the check box. This displays
a preview screen that allows you to confirm the selected printing
effects and how your document will look when printed. Some
applications do not contain the function to display the preview screen.

4 Print the document.

General

Select Printer

Status:
Location:

Ready
Comment:

Fage Fange

®al

O Pages:

Add Printer Rl

165535

Erter either a single page rumber or a singls
page range. For example, 512

[ Print to file

Mumber of copies: |1 E
L .
(1) Click Print or OK.
[J concel ]

Note You can cancel a printjob in progress by simply pressing the RESUME/
CANCEL € button on the printer.

10
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Printing with Macintosh

Note @ The menu screens and dialog boxes that appear may vary, depending on the
software application you are using.
® The steps described in this section are for printing in Mac 0S 9.

Create a document, or open a file to print.

Select the Paper Size.

(1) Select Page Setup from the application software's File menu.

Canonislon

Vers

ion 4.3 m

x

Width :8.50in

Height:11.0in

Paper Sizq: [Letter

=)

[ Borderless Printing

Amount of Extension :

Min, 0 Max. Utilities...

scale:  [100 3] %

Orientation :

[ Save Settings

Cancel

Custom...

(3) Click OK.

Specify the required settings.

(2) Select the desired paper
size from the Paper Size
pull-down menu.

(1) Select Print from the application software's File menu.

Canon i9100

Version 4.3

Letter
Normal-size
printing

(2) Select the Media Type from

e El __Cancel

Pages: @ All -
ofom [ 1 [ ]

BJ Cartridge :

[ Photo =]

Media Type : \

[Plain Paper ﬂ

[Autn Feeder

the pull-down menu.

Print Mode :
[Text

ﬂ) Details...

[ Grayscale Printing

(4) Click Print.

(3) Select a type of document
from the Print Mode pull-
down menu.

11
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12

Note @ When you select a type of document from the Print Mode pull-down
menu, the document is printed in color and print quality suited to the
characteristics of the Media Type you have selected.

Text:

Graphic:

Photo:

Manual:

Select when printing documents consisting mainly of
text.

Select when printing documents consisting mainly of
graphs and graphics (illustrations) with strong color
definition.

Select when printing documents consisting mainly of
photographs and graphics featuring fine color
gradation.

If you select Manual, the Details button becomes
selectable. Click the Details button to display the
Detailed Setting dialog box where you can fine-tune the
Print Quality and the Halftoning settings.

Refer to the User’s Guide.

For details about other printer driver functions, refer to the User’s
Guide or Help.

® You can cancel a print job in progress by simply pressing the
RESUME/CANCEL & button on the printer.
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Advanced Printing

Applications Included in the CD-ROM Package

The Setup Software & User’s Guide CD-ROMincludes photo applications designed to edit
the photographs taken by digital camera and print them as photo-lab quality prints. Please
use the application(s) suitable for your print purposes.

Note @ Toinstall applications, refer to the £asy Setup Instructions.
@ For details about photo applications, refer to the Photo Application Guide
included on the Setfup Software & User's Guide CD-ROM.

B Easy-PhotoPrint (Windows/Macintosh)

You can make Borderless Printing easily and quickly, just by selecting a photograph
taken with a digital camera and the paper type on which to print. You can also use
simple editing features, such as trimming and image rotation.

Easy-PhotoPrint is Exif Print (Exif 2.2) compatible. If you use Mac 0S 8.6- 9.x,
CarbonlLib 1.3.1 or later must be installed for Easy-PhotoPrint.

B ImageBrowser (Macintosh)

You can import photographs taken with a digital camera into a computer, edit and
caption them.

You can also make Borderless Printing or an Index Print without difficulty.

It is Exif Print (Exif 2.2) compatible.

B ZoomBrowser EX/PhotoRecord (Windows)

You can import photographs taken with a digital camera into a computer, edit, add a
caption, and print them in an album format.
PhotoRecord is Exif Print (Exif 2.2) compatible.

B PhotoStitch (Windows/Macintosh)

You can select multiple photographs and merge them to create a panoramic photo.

B Easy-WebPrint (Windows)

You can easily print pages displayed on the Internet Explorer or pages from the User's
Guide (HTML manual of this printer) in full size. Easy-WebPrint automatically adjusts
the layout when printing a screen. This feature enables you to print a screen without its
right end being cut off.

This application is a plug-in for Internet Explorer, and its toolbar is automatically added
to Internet Explorer after installation.

13
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'Windows|

Printing Borderless Photographs with Windows

This chapter describes the procedure for using the Borderless Printing mode when printing

from photo applications. These applications are included in your Sefup Software and User's
Guide CD-ROM.

Note Media Types Suitable for Borderless Printing

Media types compatible with Borderless Printing include Photo Paper
Plus Glossy (LTR, 5" x 7", 4" x 6"), Photo Paper Pro (13" x 19", LTR),
Photo Paper Pro for Borderless Printing (4" x 6"), Matte Photo Paper
(LTR), and Glossy Photo Paper (13" x 19", 11" x 17", LTR).

Follow the steps below to create color prints of digital camera photographs with Easy-
PhotoPrint using the Borderless Printing function. Easy-PhotoPrint supports Exif Print (Exif
2.2).

e Exif Print (Exif 2.2) is a new worldwide standard. Under Exif 2.2, the digital camera
can record data tags for specific camera settings and functions such as whether the
flash was on or off, if the camera was in the portrait or night scene mode, etc.

BJ Printers support Exif Print and use Easy-PhotoPrint to read the camera data
precisely, producing optimal prints.

This enables you to create prints that reproduce your vision more accurately than
ever before.

® Easy-PhotoPrint can handle only JPEG files (filename extension: .jpg and .jpeg).

1 start Easy-PhotoPrint.

This section describes the steps used for printing the photographs stored on the
memory card. Consult your memory card documentation for instructions on how to
insert the memory card into your computer.

(1) Insert the memory card into a computer.

(2) Click Start, select All Programs (or Programs), Canon Utilities, Easy-PhotoPrint,
and then Easy-PhotoPrint.
The 1.Image Selection tab is displayed.

14
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2 Select photograph.
(1) Select the memory card folder, then the folder containing the digital

photographs.
All photographs in the selected folder are displayed.

AT Ik

() My D
6 %0 My Network Places

an i
Nurber of images : 0 Paper Size : 4x6 Media Type : Phote Paper Pro 0 Page(s)

(2) Click the [+] button on the thumbnail of the photograph you want to print and

specify the number of copies.
AT o

1% 11— Increases the number of copies.
Displays the specified number of copies.

Decreases the number of copies.

15
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3 Select the paper.

@ Easy-PhotoPrint
Eile View Help

Select the printer you use.
Select the sizt

HEAE & Siee ol e of papeito beset i fhe prnker
Easy;_EhotoPrl L U b all he setings are firished, click the "3, LayouPint" tab

(1) Click the 2.Paper
Selection tab.

[]¥ivid Photo
[] Phets Noise Reduction

(2) Select the size of the
paper you want to use
from Paper Size.

(3) Select the type of the
paper you want to use

et from Media Type.

urber of images | 1 Paper Size | 4x6 Media Type : Photo Paper Pro

4 Select the layout.

16

@ Easy-PhotoPrint
File Wiew Help

Select the layout you want to print.
Check the Preview and click the “Print" button.

Eai'y{EHotoPrint Printing will stat.

(1) Click the 3. Layout/
B O == - Print tab.

Rotate: Rolate  Trimming
Left Right

(2) Select Borderless (full).

|

4 Page(s)

umber of images ¢ 4 Paper Size ; Letter Media Type : Photo Paper Pra

(3) Load the media type specified in the 2.Paper Selection tab.
(4) Click Print.
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Printing Borderless Photographs with Macintosh

This chapter describes the procedure for using the Borderless Printing mode when printing
from photo applications. These applications are included in your Setfup Software and User's
Guide CD-ROM.

Note Media Types Suitable for Borderless Printing

Media types compatible with Borderless Printing include Photo Paper
Plus Glossy (LTR, 5" x 7", 4" x 6"), Photo Paper Pro (13" x 19", LTR),
Photo Paper Pro for Borderless Printing (4" x 6"), Matte Photo Paper
(LTR), and Glossy Photo Paper (13" x 19", 11" x 17", LTR).

Follow the steps below to create color prints of digital camera photographs with
ImageBrowser using Borderless Printing.

Exif Print (Exif 2.2) is a new worldwide standard. Under Exif 2.2, the digital camera can
record data tags for specific camera settings and functions such as whether the flash was on
or off, if the camera was in the portrait or night scene mode, etc.

B) Printers support Exif Print and use ImageBrowser to read the camera data precisely,
producing optimal prints.

This enables you to create prints that reproduce your vision more accurately than ever
before.

1 start ImageBrowser.

This section describes the steps used for printing the photographs stored on the
memory card. Consult your memory card documentation for instructions on how to
insert the memory card into your computer.

(1) Insert the memory card into a computer.

(2) Double-click the Canon ImageBrowser (alias) icon on the desktop.

If the Canon ImageBrowser icon is not displayed on the desktop, open the
Canon ImageBrowser folder, and double-click the ImageBrowser icon in the
folder.

17
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2 Select photograph.

(1) Select the memory card folder, then the folder containing the digital
photographs you want to print.

All photographs in the selected folder are displayed.

wserwidow = . ... PIE
fﬁ I
S g | )
[BESloTe s - (2) Click the photograph
. g‘; you want to print.
(3) Click PRINT and select
: : Layout printing from
AUT_0004.JPG AUT_0005.JPG AUT_0006.JPG the pull_down menu.
@ @ & & & @ m

The Layout Options dialog box appears and the layout selection wizard starts.

3 Enter layout options.

Layout Options

How would you like to print your photos?

(3 Custom layout printing

) Index printing

() Fixed photo size printing

@) Tiled photo printing

(2 Canon perforated paper printing

—— (1) Select Tiled photo printing.

Specifies the number ofimages per page
and prints. Images are tiled on the page
to allow them to be printed as large as
possible.

[ Display this dialog when the Printing window displays

—— (2) Click Next.

18
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Layout Options

— Preview

Confirm the page setup and select the
number ofimages per page.

Papersize:

Height11 X Width8.50in
‘ Page setup... >

No. of images

[ Automatic Clipping:

Set Photo Area...

[ Display this dialog when the Printing window displays

Cancel ] [ < Back ] [ 0K ]
Select Borderless Printing.
Canoni9100 ( version 4.3 m
Papgr size(; [ Letter ij)—
1 [ Borderless Printing )
- Amount of Extension :

Orientation :

1]

Height:11.00in Width :8.50in

Scale : @ %

[] Save Settings

(3) Click OK.

(3) Click Page setup....

(1) Select Borderless Printing.

(2) Select a paper size from the
Paper Size pull-down menu.
The menu only displays paper
sizes compatible with
Borderless Printing.

A message box pops up. Read the message and click OK.
This returns you to the Layout Options dialog box.

19
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5

Layout Options

Confirm the page setup and select the
number ofimages per page.

Paper size :
Height11 X Width8.50in

Page setup...

No. of images

— Preview

@)

([ 1(1x1) i])

[ Automatic Clipping:

Set Photo Area...

Display this dialog when the Printing window displays

Cancel

) e (]

ROK

6 Print the photograph.

O=— nmint

BB

A

ol & 3=
=
IMAGES
FER FABE

RESATOLT RO TATES]

LAYOUT
COFTIONS

S
PRINT );/

(1) Click PRINT.

The Print dialog box is displayed.

20

Specify the number of photographs to print on one page.

Select 1(1x1) from the No.
of images pull-down menu.

-1 (2) Click OK.
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Canon 9100 Yersion 4.3
s
Copies: El m
e i [ [
EJ éﬂl’tri’ﬂl]'l!: ) ) -
2 [Phota Z]
: T ij) (2) Select a type of media for
' e _ printing from the Media Type
- pull-down menu.
=== (3) Select Photo from the Print

Mode pull-down menu.

(4) Load the selected paper in the printer.
(5) Click Print.

(Windows
Accessing Printer Driver

The Printer Properties dialog box can be opened from either within an application, or
directly from the Windows Start menu.

Note @ This manual refers to Windows XP operation.
The operations may vary depending on your operating system.
® Depending on your application program, the command and menu names
may differ, and there may be more steps involved in opening the Printer
Properties dialog box. For further details, see the user's manual for your
application.

B Opening the Printer Properties Dialog Box from Your Application
Program

1  Inyour application, select the command to print a document.

The Print dialog box can usually be opened by selecting Print from the File menu.

2 Ensure that the Canon i9100 is selected. Then click Preferences (or Properties).

The Printing Preferences (or Printer Properties) dialog box opens.

21
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B Opening the Printer Properties Dialog Box Directly from the Start

22

Menu

This method is used for maintenance operations such as print head cleaning, or to
specify printer settings common to all application programs.

When the Printer Properties dialog box is opened from the Start menu, additional tabs
appear, including the Details tab. These tabs do not appear when the Printer Properties
dialog box is opened from within an application.

For further information about these additional tabs, refer to your Windows
documentation.

Click Start and select Control Panel, Printers, and Other Hardware, and then
Printers and Faxes.

For non-XP Windows, Click Start, select Settings, and then Printers.

Select the Canon i9100 icon.

Open the File menu, and select Printing Preferences (or Properties or Main).

The Printer Properties dialog box opens.
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Adjusting Print Quality for Photographs

B Improving the Quality of Printed Images
Two important factors control the quality and output of your printed images:

Paper and Ink

Using recommended Canon paper, specialty media, and inks for printing
photographs can significantly improve the quality of your printouts. See the inside
back cover for a list of Canon media and inks for this printer.

Printer Driver Settings

The printer driver has a variety of settings that can be used to creatively enhance the
colors and output of your photographs. Many of these features are covered in this
chapter.

For more detailed information, see the /9700 User’'s Guide on the Setup Software &
User's Guide CD-ROM.

You can also access the online help in either of the following ways depending on your
operating system:

(Windows|

® Press the F1 key
e Click ? in the upper right corner, then click the feature you want to know more about.
e (Click the Help button when displayed.

e Turn on Balloon Help by clicking Help, then Show Balloons.
B Adjusting Print Quality

Features that affect the appearance and quality of your printed images can be
controlled with the printer driver.

The i9100 automatically adjusts printer settings to improve print quality based on the
media type (plain paper, Photo Paper Pro, and so on). You can also customize the Print
Quality settings if desired.

23
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To manually adjust Print Quality settings:

(Windows

1 Open the Printer Properties dialog box.

See"Opening the Printer Properties Dialog Box from Your Application Program"
on page 21.

2 Select Custom in Print Quality, then click Set... to open the Set Print
Quality dialog box.

3 Move the slide bar to adjust the Print Quality.

Set Print Quality

5 4 1

ek st 4 S @
3

ast Fine
Haltoring & g
Aute
& spool data size

Diffusion

ok [ Cancel | [ Heb

4 When the process is complete, click OK.

1  Open the Print dialog box.

See "Printing with Macintosh" on page 11.

2  Click Print Mode and select Manual, then click Details... to open the
Detailed Setting dialog box.

3 Move the slide bar to adjust the Print Quality.

Canon Detailed setting

. ] PrintQuality: Fast e=f————os Fine

uuuuuuu ot Gty !
Specialetrects i

=]

& ([

......

::: .

Diffusion
—I (Restore Defaults Cancel 0K

4 When the process is complete, click OK.

24
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To automatically optimize the image:

Photo Optimizer PRO automatically adjusts the photographic images created with a digital
camera. Use this feature to compensate for unsatisfactory color balance and over- or
under-exposure before printing.

(Windows

1

S WN

S~ N R

Open the Printer Properties dialog box.

See"Opening the Printer Properties Dialog Box from Your Application Program"
on page 21.

Click the Effects tab.
Select the Photo Optimizer PRO check box.

Click OK.

Open the Print dialog box.
See "Printing with Macintosh" on page 11.

Click Print Mode and select Manual, then click Details... to open the
Detailed Setting dialog box.

Click [ \5L] (Special effects).
Select the Photo Optimizer PRO check box.

Canon Detailed Setting

[ simulate illustration

Contrast: )

ccccc

1 (Gestore befaurs) Cemee) )

Click OK.

25
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To use Vivid Photo option:

Vivid Photo intensifies background colors for fields, trees, oceans and skies, while
maintaining natural skin tones in the images.

Note InWindows Me or Windows 98

The Vivid Photo function is not available, if Background Printing has
been disabled.

(Windows

To use Vivid Photo, select the Vivid Photo check box on the Effects tab.

59 Man | 53 Page Setup | ®) Stamp/Backgiound | ## Effects | (§ Profies | b} Mantenance

[ Simuiste lHustration

[ Monockrome Efscts:

[ mage Optmizr
[ Photo Optimizer PRO
] Phate Noise Reduction

To use Vivid Photo, select the Vivid Photo check box under the Special Effects.

Canon Detailed Setting

= [ Simulate illustration
—o—- Contrast: s
auatity
[0 Monochrome effects :
. | color: O
Special e %
ﬁ; v i M vivid Phntn)
m, [ Photo Optimizer PRO
[ Apply Throughout Page
[ Photo Neise Reduction :
Normal +
—! (Restore Defaults | [Ccancel J [ o]
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To reduce noise from images taken with a digital camera:

Photo Noise Reduction function reduces noise from blue portions, such as the sky and dark
portions of the images taken with your digital camera.

Note In Windows Me or Windows 98

The Photo Noise Reduction function is not available, if Background
Printing has been disabled.

(Windows

To use Photo Noise Reduction, select the Photo Noise Reduction check box on the
Effects tab.

2 printing Preferences 7))
| © Main| 3 Page Setup| @) stamp/Bac) ## Effects [ (5 Profles| §§ Maintenance

L] Simuste lHustration

[] Monochrome Efiscts

i [ yiidPhots
| § ot
; [ Photo Optimizer FRO 3
| (D [ Pheis Heise Hedutort [Nomadl v)
j
- | ) )

To use Photo Noise Reduction, select the Photo Noise Reduction check box under the
Special Effects.

Canon Detailed Setting

[ simulate illustration
Contrast: oo

D monochrome eftects

Color: e [

| [Jvivid Photo

[ Photo Optimizer PRO
[ Apply Throughout Page
[ Phota Noise Reduction :

Normal =
g =
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B Saving and Recalling Driver Settings

28

When you change the printer driver settings for a specific print job, such as printing
black and white photos, or printing documents with a special background, you can
save and name the settings for future use on similar print jobs.

'Windows

1 Open the Printer Properties dialog box.

See "Opening the Printer Properties Dialog Box from Your Application
Program" on page 21.

Click the Profiles tab.
Enter new settings in Profiles.

WN

——(1) Click Add to Profiles.

Com )

The Add to Profiles dialog box opens.

MdtoProfes  [PX
—————— (2) Enter a name of profile for
( EEEEELY) registering settings.

— L1 (3) Select an icon.

—-1— (4) Enter a description on the
registering profile.

Click OK.

Click OK on the Profiles tab.
This registers your printer driver print settings.

V>

Note You can retrieve or delete the print settings profile at any time.
Retrieving profile:
Select the desired profile from Printing Profiles, and click
Retrieve from Profiles.
Deleting unwanted profile:
Select the desired profile from Printing Profiles, and click Delete.
For details, click Help and refer to the topics of this function.
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(92

Open the Print dialog box.

See "Printing with Macintosh" on page 11.

Click Apply.
The Register Settings dialog box opens.

Enter the print settings to register.

Canon Register Settings

Settings :

Factory Defaults

Defautts... | (Remove{ (CApplyn | J—— (1) C“Ck Apply....
Import

The dialog box to enter the new settings name opens.

New Settings Name :
Unknown 44— (2) Enter a name under which
cancel | ok to register your settings.
Click OK.

Click Close in the Register Settings dialog box.

This registers your printer driver print settings.

Note You can retrieve or delete the saved driver settings at any time.

Retrieving print settings:

Select the name of the settings to retrieve from the Settings list
and click Import.

Deleting unwanted drivers settings:

Select the name of the settings to delete from the Settings list
and click Remove.
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Using Printer Driver Options

Your printer driver provides you with many features that allow you to print a wide range of
images and documents.
The illustrations below provide a basic introduction to many of these.

Note For detailed descriptions of the printer driver functions, refer to the User’s
Guidelocated on your Setup Software & User’s Guide CD-ROM.

Printing with Borderless Printing Reducing Noise from Images Taken with
Digital Camera

Smoothing the Rough Edges of Certain
Images Page

Adding Illustrated Effect to Documents
Resizing the Image by Selecting the Scaling

Ratio
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Printing Maintenance
Replacing an Ink Tank

When replacing an ink tank, check the model number very carefully.
The printer will not print properly if a wrong ink tank is used, or if an ink tank is installed in
the incorrect position.

With this printer, ink tanks must be installed from the right in the order indicated below.

¢ Yellow: BCl-6Y
¢ Magenta: BCl-6M
e Cyan: BClI-6C

Photo Magenta: BCI-6PM Photo
Photo Cyan: BCI-6PC Photo
Black: BCI-6BK

B Knowing When to Replace an Ink Tank

If an ink tank needs to be replaced, the POWER lamp changes from green to orange and
flash four times, as soon as printing begins. It is important to quickly identify the
empty tank using the BJ Status Monitor (Windows) or error messages (Macintosh) and
replace it.

Note [fmissing characters or white streaks appear despite sufficient ink levels, refer

to the section "When Printing Becomes Faint or Colors are Incorrect” on page
36.
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(Windows|

The following message appears when an ink tank is empty. Printing resumes as soon as the
ink tank is replaced and the front cover is closed.

e The ink tank with [X] symbol is out of ink.
e Replace it with a new ink tank.
“You can continue printing under the ink out
e oy
bl * Press the RESUME/CANCEL button on the
ik ot condion printer to resume printing with the empty
Tlge following ink tanks have run out ink tank.
SR . . . . . .
When printing is finished, replace the ink
tank immediately. If you continue
printing with an empty ink tank, it may
cause the machine to malfunction.
® Menu screens will vary to some degree,
depending on your software environment.
Empty ink tank

Note When Low Ink is Detected
The BJ Status Monitor appears as soon as a print job starts.

['] Indicates a low ink level. Obtain a replacement ink tank as soon as
possible.

(i) Canon i9100 - USBOO1
Option  Help

 Printer Status ||

Printer is online.

¢ Click Cancel Printing to
cancelthe current print
job.

The follawing ink tanks are running law.

Ink tank with low ink level

Paper Thickness Lever Position:  Left

Dvner. testl
Document Name: Document
Piinting Pages

Cancel Piinting | [ Display Print Gueue
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The following message is displayed when an ink tank is empty. Printing will resume as soon as the
ink tank is replaced and the front cover is closed.

é i9100 Error Number : D1
The cyan ink has run out. Open the printer

front cover and load a new ink tank. When
this is completed, close the front cover.

613

Note When Low Ink is Detected
The following message is displayed as soon as a print job starts.

* Press the RESUME/CANCEL button on
the printer to resume printing with the
ink tank empty. When printing is
finished, replace the ink tank
immediately. If you continue printing
with an empty ink tank, it may cause
the machine to malfunction.

['] Indicates a low ink level. Obtain a replacement tank as soon as

possible.

Canon i9100

Yersion 4.3

Document Name :
Printing Page :
Printing

mkievet ] ] @D

Picture 1

1 Pages 1 Copies

(37%)

The following ink is running low.
Magenta

Ink tank with low ink
level
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B Replacing an Ink Tank
When ink tanks run out of ink, replace them following the procedure described below.

1  Ensure that the printer is on, and then open the front cover.

The print head holder moves to the center.

2 Remove the empty ink tank.

Push the tab and remove the ink tank.

Do not touch the
lock lever; remove
only the ink tank.

Important ® Handle ink tanks carefully to avoid staining clothing or the
surrounding area.
® Discard empty ink tanks according to the local laws and regulations
regarding disposal of consumables.

3 Prepare a replacement ink tank.

(1) Unpack the new ink tank and pull off the orange tape.
(2) Remove the orange protective cap from the bottom of the ink tank and discard it.
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Important ® Do not squeeze the sides of the ink tank, as this may cause the ink to
leak out and stain your clothes and hands.
® Do not re-attach the protective cap once you have removed it.
® Once the protective cap is removed, do not touch the open ink port.

Install the new ink tank.

(1) Insert the ink tank in the print head holder.
(2) Press on the "PUSH" mark until the ink tank snaps firmly into place.

Close the front cover.

The print head holder moves to the right. The ink tank installation process is now
complete.

Note @ To maintain optimal print quality, use an ink tank within six months

of its first use.

® Once anink tank has been used, do not remove it from the printer
and leave it out in the open. An ink tank left out in the open and then
reinstalled into the printer may not function.

® Colorink may be consumed even when a black-and-white or
grayscale printing is specified.
Colorink is consumed in the head cleaning and deep cleaning, which
are necessary to maintain the printer’s capabilities.
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When Printing Becomes Faint or Colors are Incorrect

When printing becomes faint or colors are incorrect, even if ink remains in the ink tanks, see
if the print head nozzles are clogged and clean them. Follow the procedures below to
maintain the print head.

Important Before maintaining the print head, check the following:

® Open the front cover and make sure that the ink tank contains ink. If it is out
of ink, replace it.

® Ensure that the orange tapes from the ink tanks have been peeled off.

® Press "PUSH" on the ink tank and ensure that the ink tank is installed
securely.

® Increase the Print Quality setting in the printer driver settings.

"“Printing the Nozzle Check Pattern" on page 37

If the print quality is poor If white stripes are noticeable

Step 2
“Aligning the Print Head" on page 44

Step 2
“Print Head Cleaning" on page 39

If the problem remains

Step 3
"Print Head Deep Cleaning" on page 42

@ Note If print head maintenance does not resolve the problem, contact the Customer
Care Center.
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Printing the Nozzle Check Pattern

Print the nozzle check pattern to determine whether ink ejects properly from the print head
nozzles, and to verify print head alignment. Use this function if printed results are blurred or
if the color is incorrect.

(Windows|

With the printer on, load a sheet of paper in the printer.

2 Open the Printer Properties dialog box.

See "Opening the Printer Properties Dialog Box Directly from the Start Menu" on
page 22.

3 Print the Nozzle Check Pattern.

& Canon i9100 Printing Preferences

D tain| 53 Page Seng| & StamprBackgownd | of Eieot | (3 Prors| b M ——— (1) Click the Maintenance tab.

- @ (2) Click Nozzle Check.

Prirt Nozele Check Power Off

™
I I

Custom Settings [t

o

Q5 Start Status Monito,

ok [ cemel ] Hef

(3) When the confirmation message is displayed, click OK.
See "Examining the Nozzle Check Pattern" on page 39.
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With the printer on, load a sheet of paper in the printer.

2 Open the Printer Utility dialog box.
(1) Select Page Setup... in the File menu.
(2) Click Utilities to open the Printer Utility dialog box.

3 Print the Nozzle Check Pattern.

Canon 9100 Printer Utility Yersion 4.3
[estprint =) (1) Select Test Print from the
D Nozzle Check pull-down menu.
Prints a nozzle-check pattern.

(2) Click Nozzle Check.

m Print Head Alignment
It will align the print heads to correct any
error in their installation position.

Close

(3) When the confirmation message is displayed, click OK.
See "Examining the Nozzle Check Pattern" on page 39.
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B Examining the Nozzle Check Pattern

The nozzle check pattern should appear as follows when ink is discharged properly.
Examine the nozzle check pattern output by the printer.

— (1) Lines missing here indicates that the
print head requires cleaning.

> = <L See "Print Head Cleaning" on page 39.
. [ (2) Unevenness in these patterns indicates
L - J that the print head requires alignment.
See "Aligning the Print Head" on page 44.
Print Head Cleaning

Clean the print head if you suspect that the nozzles might be clogged. Cleaning the print
head consumes ink, so perform print head cleaning only when necessary.

'Windows|

Ensure that the printer is on.
2 Open the Printer Properties dialog box.

See "Opening the Printer Properties Dialog Box Directly from the Start Menu" on
page 22.
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3 Start Print Head Cleaning.

& Canon i9100 Printing Preferences

® 5

Prirk Head Algnment Nozzle Check Power Off ko Power
Custom Settings Quiet Mode

Q5 Start Status Monitor,

(1) Click the Maintenance tab.

(2) Click Cleaning.

(3) When the message is displayed, click OK.

1 Ensurethe printer is on.

2 Open the Printer Utility dialog box.
(1) Select Page Setup... in the File menu.

(2) Click Utilities... to open the Printer Utility dialog box.
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Start Print Head Cleaning.

Canon i9100 Printer Utility Yersion 4.3
- =) .
~{(Geanng ) (1) Select Cleaning from
Cleaning the pull-down menu.
Starts print-head cleaning.

Deep Cleaning
Starts print-head deep cleaning. |_ . .
(2) Click Cleaning.

Close

(3) When the message is displayed, click OK.

Important Do not perform any other operations until print head cleaning
finishes. The cleaning process takes about 50 seconds.

@ Note @ Print head cleaning can be performed also from the printer itself.
Ensure the printeris on. Hold down the RESUME/CANCEL button until
the POWER lamp flashes once, then release.

® After print head cleaning finishes, print the nozzle check pattern to
verify that the print head nozzles are clean.

See "Printing the Nozzle Check Pattern" on page 37.
If the problem persists, perform print head deep cleaning.
See "Print Head Deep Cleaning" on page 42.
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Print Head Deep Cleaning

If the print quality does not improve by standard print head cleaning, try performing a print
head deep cleaning, which is a more powerful process. Print head deep cleaning consumes
ink, so perform this procedure only when necessary.

'Windows|

1 Ensurethe printer is on.

2 Open the Printer Properties dialog box.

See "Opening the Printer Properties Dialog Box Directly from the Start Menu" on
page 22.

3 Start Print Head Deep Cleaning.

& Canon i9100 Printing Preferences

© Main | 3 Page Selup| &) Stamp/Backgiound | o Effects | C§ F’ruhl (1) Click the Maintenance tab'
i jcy ] = (2) Click Deep Cleaning.

(3) When the message is displayed, click OK.
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1 Ensurethe printer is on.

2 Open the Printer Utility dialog box.
(1) Select Page Setup... in the File menu.

(2) Click Utilities... to open the Printer Utility dialog box.

3 Start Print Head Deep Cleaning.

Canon i9100 Printer Utility

Version 4.3

{[ Cleaning ﬂ )

@ Cleaning
Starts print-head cleaning.

@ Deep Cleaning
arts print-head deep cleaning.

Close

(1) Select Cleaning from the pull-down
menu.

(2) Click Deep Cleaning.

(3) When the message is displayed, click OK.

Important The process takes one or two minutes to complete, so simply wait until

the POWER lamp stops flashing.

@ Note Afterprint head deep cleaning finishes, print the nozzle check pattern to
verify that the print head nozzles are clean.

See "Printing the Nozzle Check Pattern" on page 37.

If the print head is still not clean, repeat print head deep cleaning and
the nozzle check pattern printing up to three times. If the problem
persists, the print head may be worn out. Contact the Customer Care

Center.
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Aligning the Print Head

(Windows|

With the printer on, load a sheet of paper in the printer.

2 Open the Printer Properties dialog box.

See "Opening the Printer Properties Dialog Box Directly from the Start Menu" on

page 22.

3 Print the pattern.

& Canon i9100 Printing Preferences

[ Han %2 PageSeup| @ StamprBackground | w# Effects | (8 Pilfies| @b Maiten

= =

(1) Click the Maintenance tab.

Cleaning Desp Clearing
& |
Prirk Head Alignment Nozzle Check Power Off
Custom Settings Quiet Mode

% Start Status Monitor. |

Canon i%100

9
g

Did the pattern print successfully?

If nothing was printed, or if the pattern is noticeably Faint or patchy, dick Mo and try again.

s L

(2) Click Print Head Alignment.

(3) When the confirmation message
is displayed, click OK.

44

(4) After the pattern is
printed, click Yes.
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4 Align the Print Head.

(1) Look at the printout. Select the patterns that have the fewest white stripes and
enter the numbers that correspond to the selected patterns.

Print Head Alignment E] X

Frint head alignment is being executed. Refering to printed
pattemns & to F, select the pattern that shows no flaws.

Haorizontal Alignment [-3 ta +7]

A G —— (2) Enter the numbers.
Magenta,

C
D. Photo Cyan:
E

Phato b agenta:

#—+— (3) Click OK.

Note [fitis difficult to pick up the best pattern on F, pick the setting that
produces the least noticeable vertical white stripes.

Less noticeable white stripes More noticeable white stripes

Canon i%100

\l}) Frint head alignment s naw camplete.

(4) Click OK.
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46

Ensure the printer is on.

Open the Print Utility dialog box.

(1) Select Page Setup... in the File menu.
(2) Click Utilities... to open the Printer Utility dialog box.

Print the pattern.

Canon 9100 Printer Utility Yersion 4.3

{[ Test Print ﬂ)

Nozzle Check
Prints a nozzle-check pattern.

Print Head Alignment
It will align the print heads to correct any
errorin their installation position.

Close

Print head alignment is being executed.
Alighment entails printing, so do the
following: Ready the printer (connect the
cable and turn the power on), move the
printer's paper thickness lever to the left,

(1) Select Test Print from
the pull-down menu.

(2) Click Print Head Alignment.

(3) Click OK.
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Align the Print Head.

(1) Look at the printout. Select the patterns that have the fewest white stripes and
enter the numbers that correspond to the selected patterns.

Print Head Alignment

Print head alignment is being executed. Referring to printed patterns
AtoF,select the pattern that shows no flaws.

Adjust sideways{-3~+7’
A. Black:

(2) Enter the numbers.

B. Cyan:
C. Magenta:

(T OTHITT

D. Photo Cyan:

(Ccancet J(([Send JH—  (3) Click Send.

Note [fitis difficult to pick up the best pattern on F, pick the setting that
produces the least noticeable vertical white stripes.

L I

Less noticeable white stripes More noticeable white stripes
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Troubleshooting

Troubleshooting usually falls into one of the following categories. In this chapter you will
find the most common printing problems.

“Cannot Install the Printer Driver" on page 50

"“Print Quality is Poor or Contains Errors" on page 51
"Troubleshooting Printer Hardware" on page 53
"Paper Does Not Feed Properly" on page 54

"Handling Error Messages" on page 55

“An Error Message Appears on the Screen" on page 56

Refer to the User’s Guidefor additional information on topics not covered in this section.

Note |fyouencounterany problem during installation or operation of your

printer, quickly scan all topics to find a solution. If the problem persists,
contact the Customer Care Center at (757) 413-2448. ATDD service
(telephone device for the deaf) is also available at (866) 251-3752.

(Windows|

When Error Occurs

The BJ Status Monitor opens and displays a message. Take the
appropriate action described in the message.

The message may vary depending on your operating system.

Canoel Printing | | Display Print Qusue:

When using Windows Me or Windows 98, click the Guide tab and follow
the on-screen instructions.
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Cannot Install the Printer Driver

Problem

Cannot Install the
Printer Driver

Possible Cause

Installation
procedure not
followed correctly

‘ Try This

Follow the installation instructions from the £asy Setup Instructions packaged with
your printer.

[Windows |
Note If the installer was forced to terminate due to an error, Windows
may be unstable. Remove the CD-ROM from the CD-ROM drive,

and restart the computer. Try reinstalling the printer driver.

If the problem persists, refer to your Windows documentation
for more information.

Other applications
running in the
background

Other applications opened on your computer can interfere with the installation
routine. Close all opened software applications before reinstalling the printer
driver. Refer to the £asy Setup Instructions for installing the printer driver.

Installation does
not start
automatically when
the CD-ROM is
inserted into the
drive

‘Wi

If printer driver installation did not start automatically when you insert the CD-
ROM into the CD-ROM drive:

1. Click Start and select My Computer.
2. Double-click the CD-ROM icon.

For non-XP Windows, open the My Computer window, and double-click the CD-
ROM icon.

Double-click the CD-ROM icon on your desktop to start installation.

Installation CD-
ROM not working

properly

Confirm that there are no problems with the Setup Software & User’s Guide CD-
ROM.

‘W
Use Windows Explorer to confirm that the CD-ROM can be read.

Confirm that the CD-ROM icon is displayed on the desktop.
If there is any problem with the CD-ROM, contact the Customer Care Center.

Unable to proceed
beyond the Printer
Port screen

'Windows Reinstall the printer driver

1. Click Cancel.
2. When the Terminate Installation screen
is displayed, click OK.

3. Click Exit, then remove the CD-ROM.
4. Turn the printer and the computer off.
5

6

. Restart the computer.

. Carefully follow the procedures
described on the £asy Setup
Instructions and reinstall the driver.
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Print Quality is Poor or Contains Errors

Problem

Ink does not eject
properly/Printing
isBlurred/ Colors
are Wrong /
White Streaks
Appear

Possible Cause |

Ink tank is not
seated properly/Ink
tank is empty

LALTS
Check that the ink tanks are firmly seated in the print head and reseat them if
necessary.

® Check to see if all the orange tapes have been peeled off as shown in (1). If
there remains a part of the orange tape as shown in (2), remove it thoroughly.

If an ink tank is empty: See"Replacing an Ink Tank" on page 31.

Media not loaded
with the print-side
up

Check that your paper is loaded with the print side facing up.

Note Follow the instructions packaged with your specialty media for

loading and handling.

Incorrect paper type

o
On the Main tab, confirm that the Media Type selected matches the paper loaded.

In the Print dialog box, confirm that the Media Type selected matches the paper
loaded.

Print head is Align the print head.

misaligned See "Aligning the Print Head" on page 44.

Print head is Print the nozzle check pattern to check for uneven ink output.

clogged When a specific color is missing from the nozzle check pattern, clean the print

head.
If ink supply is uneven: See "Print Head Cleaning" on page 39.

Note The ink tank may be clogged with dust or air if the protective

cap is replaced after the removal.

Print Quality not set
properly

Be sure to set the Print Quality setting to High.
o
On the Main tab, click High for the Print Quality setting.

1. Select Manual in the Print Mode pull-down menu in the Print dialog box, and
then click Details.

2. Click the Quality icon and then drag the Print Quality slide bar to the Fine end.

Printer will not
print edge to
edge

Amount of
extension is small

Set the Amount of Extension slider bar to the right end.

Paper size set
incorrectly

Confirm that the margin of the created data is set to 0 mm.

Also, confirm that the Page Size setting matches the size of the paper loaded in
the printer.
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Problem

Printed Paper
Curls or Ink Blots

Possible Cause |

Paper being used is
too thin

LALTS
Use High Resolution Paper or Photo Paper Pro to print images that require a lot of
ink (i.e. pictures with intense colors or photographs).

Color Intensity
setting is too high

Reduce the Intensity setting in the printer driver and try printing again.

‘Wi

1. Open the Printer Properties dialog box.

2. On the Main tab, select Manual for Color Adjustment, and then click Set.
3. Drag the Intensity slide bar to adjust the intensity.

1. Open the Print dialog box.
The Print dialog box can be opened by selecting Print in the File menu.

2. In the Print Mode pull-down menu, select Manual and then click Details.
3. Click the Color icon, then drag the Intensity slide bar to set the intensity.

Paper feed roller is
dirty

Clean the paper feed roller.
See "Paper Does Not Feed Properly" on page 54.

Printed Surface is
Scratched

Inappropriate paper
type used

Check to see if the paper you are printing on is too thick or curled.
See "Print Media to Avoid" on page 4.

Note that smudging may occur at the top and bottom edges of the paper when
using Borderless Printing. Make sure that the paper you are using is compatible
with Borderless Printing.

See "Media Types Suitable for Borderless Printing" on page 14.

Incorrect position of
the paper thickness
lever

When printing on thick paper, set the paper thickness lever to the “ = ”"mark.

This widens the gap between the print head and the paper. If the paper is
scratched even when printing on plain paper, also try this as well.

Printed Output
does not Match
Screen

Color Adjustment
for Driver Settings
is not set properly

Select Manual for Color Adjustment, and set Color Balance or Enable ICM.
Select Color Sync for Color Correction, and set the color settings.
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Troubleshooting Printer Hardware

Problem

Printer Does Not
Start or Printer
Stops During
Print Jobs

Possible Cause ‘

Print head has
overheated due to
long periods of
continuous printing

Try This

Stop printing and turn the printer off for at least 15 minutes to allow the print head
to cool down.

The print head tends to overheat when printing continues for a long period of time.
The print head is designed to automatically pause at line breaks before resuming
printing in order to cool down.

Caution The area around the print head can become extremely hot
during extended print operation. Always avoid touching the

print head and its peripheral components.

Printing high-
resolution
photographs and
graphics

Wait until the print job finishes.

The POWER lamp flashes green while the print data is being processed. Printing
photographs and high-density graphics can take time.

Printer cable is too
long

Avoid using USB cables longer than 6.6 feet.

There may be
problems in your
operating system

Restart your computer. It may solve the problem.

Delete undesired print jobs if there is any. Use B) Status Monitor in Windows, or BJ
Print Monitor in Macintosh, for the deletion.

Ny

1. Open the Printer Properties dialog box.

See "Opening the Printer Properties Dialog Box Directly from the Start Menu"
on page 22.

2. Click Maintenance tab and then Start Status Monitor.
3. Click Display Print Queue.

4. Select Cancel All Documents in the Printer menu.
Click Yes when a confirmation message appears.
The print job is deleted.

Note In Windows Me or Windows 98

Click to select an undesired document and select Purge Print
Documents in the Printer menu.

1. Double-click BJ Print Monitor in Extensions in the System Folder.

2. Click to select an undesired document and click [&.
The print job is deleted.

Cannot Print to
End of Job

Incorrect page size
selected

Verify that the page size setting matches the size of the paper loaded in the
printer:

- Check the Paper Size setting from within your application to ensure that it
matches the size of the paper loaded.

- Check the Page Setup tab in the Printer Properties dialog box (for Windows), or
the Page Setup dialog box (for Macintosh), to ensure that it matches the size of
the paper loaded.

Not enough free
space on hard disk

Your operating system may be out of free disk space.
Check the available space on your computer’s hard disk.
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Cannot Print to
End of Job (con’t)

The size of the print
datais too large

W,

Check the size of the print data. For Windows XP and Windows 2000, if the size of
the data is too large, part of it may be lost. When the spool format is EMF, follow
the procedure below.

1 Open the Printer Properties Dialog Box.
2 On the Main tab, select Custom as the Print Quality setting, and click Set...
3 Click Reduce spool data size.

Note  When Reduce spool data size is set, the print quality may be

degraded.

Paper Does Not Feed Properly

Problem

Paper Does Not
Feed Properly

Possible Cause ‘

Inappropriate paper
type used

LALTH
Check to see if the paper you are printing on is too thick or curled.
See "Print Media to Avoid" on page 4.

Paper feed roller is
dirty

Follow the steps described below to clean the paper feed rollers.

If envelopes or post cards do not feed properly, even after correcting any paper
curl, clean the paper feed roller.

1. Ensure the printer is on and there is no paper loaded in the printer.

2. Hold the RESUME/CANCEL button down and release after the POWER lamp
flashes three times.
The paper roller rotates as it cleans.
Repeat this cleaning operation three times.

3. Load a sheet of plain paper in the printer.

4. Hold the RESUME/CANCEL button down and release after the POWER lamp
flashes three times, then feed the sheet of paper.
Repeat this operation three times.

If the printer still does not feed the envelopes or post cards properly into the
printer even after the cleaning operation, repeat the procedures.

Paper Jams

1. Gently pull the jammed paper out of the sheet feeder slot or the paper output
slot, whichever is easier.

e |f the paper tears and some of it is left in the printer, turn the printer off, then
open the front cover, and remove the piece of paper. Do not touch the internal
parts in the printer. If you cannot reach or remove the torn paper, do not
attempt to disassemble the printer yourself. Contact the Customer Care
Center.

¢ If you cannot extract the paper, turn the printer off, and then turn it back on.
The remaining paper will be ejected automatically.

2. Close the front cover and reload the paper into the sheet feeder, then press the
RESUME/CANCEL button on the printer.
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Handling Error Messages

When a printer error occurs, the POWER/ERROR lamp flashes. The number of flashes
indicate the type of error that has occurred. Count the flashes and take the appropriate
action to correct the error.

Note the number
of flashes

Green (lights =» Flashes =» Green (lights =» Flashes
longer than orange) orange longer than orange) orange )Repeats

Number of Possible Cause LALTH
flashes
Two flashes Printer is out of Reload paper and press the RESUME/CANCEL button.
paper
Three flashes Paper jam If a paper jam occurs, clear the jammed paper, reload paper in the printer, then

press the RESUME/CANCEL button. See "Paper Jams" on page 54.

Four flashes Empty ink tank Press the RESUME/CANCEL button to resume printing with an empty ink tank.
Replace it with a new ink tank immediately after the printing. It may damage the
printer if you continue printing with an empty ink tank.

See "Replacing an Ink Tank" on page 31.

Six flashes Print head not Install the print head. If the print head is already installed, remove the print head
installed and check the electrical contacts for foreign matter, then reinstall.

After reinstall the print head, you may need to realign it.

Seven flashes Defective print Remove and reinstall the print head. Ensure that the protective cap has been
head removed. If re-installing the print head does not resolve the problem, contact the
Customer Care Center to replace it with a new one.
Eight flashes Waste ink tank The printer has a built-in waste ink tank to hold the ink consumed during print
almost full head cleaning.

Eight flashes indicate that this tank is nearly full.
Press the RESUME/CANCEL button to clear the error so printing can continue.
Contact the Customer Care Center to have the waste ink tank replaced

immediately.
Note POWER lamp flashes Turn off and unplug the printer from the power supply. Then plug the printer back
alternately in green and in and turn it back on. If the problem persists, contact the Customer Care Center.

orange
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Troubleshooting

An Error Message Appears on the Screen

Problem
W
Error Writing /

Output to USBnnn
(or USBPRNnn)

Possible Cause
Printer not ready

Try This
The power lamp flashes green when the printer is warming up, or when a print

job is being sent to the printer. It glows a steady (non-flashing) green when it is
ready for use or when the print job is completed.

Paper is not loaded

Load paper and press the RESUME/CANCEL button.

Faulty connection

Ensure the printer cable is securely connected to the computer.

Note If you are using a switching hub or other device, disconnect the
printer and reconnect it directly to the computer and try
printing again.

If successful, the problem may have been with the device.
There could also be a problem with the cable(s). Replace the
cable(s) and try printing again.

Printer driver is not
installed properly

Uninstall then reinstall the printer driver.
1. Click Start, select All Programs (or Programs), Canon i9100, and Uninstall.

2. Follow the on-screen instructions to uninstall the driver.
Follow the procedures described in the £asy Setup Instructions and reinstall
the printer driver.

“Error No.: X202”

Not enough
memory

Increase available memory by closing any other applications currently running.

“Error No.: X203”

Printer driver fault

The printer driver may not be installed correctly. Uninstall, then reinstall the
printer driver.

Refer to the User’s Guide for instructions on how to uninstall the printer driver.

“Error No.: X300”

Printer not ready

If the POWER lamp is off, turn the printer on.

If the POWER lamp is flashing green, the printer is initializing. Wait until the
POWER lamp stops flashing.

Printer not properly
connected

Ensure the printer is securely connected to the computer.

Note If you are using a switching hub or other device, disconnect
the printer and reconnect it directly to the computer and try
to print again.

If successful, the problem may have been with the device.
There could also be a problem with the cable(s). Replace the

cable(s) and try printing again.

Printer not selected
in chooser

[y

. From the Apple menu, select Chooser.

2. Click the 9100 icon and ensure that the i9100 is selected as the target
connection.
If not, select it.

Note If the problem persists, delete all unnecessary documents

from the Extensions and the Control Panels folder.

56




Appendix

Appendix

Installing the Printer Driver when using Mac OS 9.x

When using other than Mac OS X (Mac OS 8.6 or later), install the printer driver, following
the procedure below.
Screen shots may differ depending on the operating system used.

1

N

N Ui &~ W

9

Turn on your Mac and insert the Sefup Software & User's Guide CD-ROM.
TURN THE PRINTER ON.

Open the Mac OS 8.6-9.x folder on the CD-ROM, then double-click the Printer
Driver folder.

Double-click the Installer icon in the Printer Driver folder.
Read the License Agreement and click Accept, if you agree.

Click Install.

The printer driver will load automatically.

If the message "No other applications can be running..." appears, click
Continue.

When the "Installation was successful" screen appears, click Restart.

From the Application folder, double-click on the software to be installed.
Follow the on-screen instructions.

When the "Installation has Finished" screen appears, click OK.

10 when prompted, restart your computer.

11 Select the Apple menu, then Chooser.
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12 Click the i9100 icon in the Chooser.

13 Close the Chooser.

Note Registeryour product at www.registercanon.com to ensure product
support.

14 To ensure highest quality output, continue with Step 7 Align the Print Head
on the Easy Setup Instructions.
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User’s Guide Table of Contents

Your printer’s User’s Guide offers detailed information on the following topics.

How to Use This Manual
Printer Parts and Their Function

Useful Printing Techniques

Printing with Borderless Printing

Reducing Noise from Images Recorded
with Digital Camera

Achieving Vivid Reproduction of Images
with Lots of Greens and Blues

Printing with Color and Brightness
Automatically Optimized

Adjusting Print Quality

Smoothing the Rough Edges of Certain
Images

Automatically Resizing the Image to Fit
the Page

Resizing the Image by Selecting the
Scaling Ratio

Printing Multiple Pages on a Single Page

Enlarge a Document by Printing it on
Multiple Pages

Printing Multiple Pages for Assembly into
a Booklet

Printing on Both Sides of the Page

Printing Stamped Messages on
Documents

Printing Background Images on
Documents

Adding Illustrated Effect to Documents
Printing the Entire Image in Single Color
Printing in Grayscale

Reversing the Page Printing Order
Printing on Nonstandard Size Paper
Reducing the Sound of Printer Operation
Registering Printer Driver Settings

Printing Media
Compatible Media Types
Envelopes
High Resolution Paper

Glossy Photo Paper

Photo Paper Pro

Photo Paper Pro (Perforated)
Photo Paper Plus Glossy
Matte Photo Paper
Transparencies

T-Shirt Transfers

Checking the Status of the Printer

BJ Status Monitor Functions
BJ Print Monitor

Troubleshooting

Cannot Install Printer Driver
Print Quality is Poor

Printer Does Not Start or Stops During
Print Jobs

Paper Does Not Feed Properly or Paper
Jams

The POWER Lamp Flashes Orange

An Error Message is Displayed on the
Screen

Problems Unique to Windows
Problems Unique to Macintosh

Appendix

Printing Area

Using the Printer with a Network
Uninstalling Printer Drivers
Uninstalling the User’s Guide
Transporting Printer

Printer Driver Functions (Windows)
Printer Driver Functions (Macintosh)
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Specifications

Printer
Printing resolution:

Print speed

*print speed may vary with the content of the
document and the processing speed of the
host computer.

Print width:

Resident print control mode:
Receive buffer:

Interface:

Acoustic noise level:

Operating environment:
Storage environment:
Power supply:

Power consumption:
Dimensions

(without a paper rest and paper output tray) :

Weight:

Graphic image printing:

Print Head:

60

4800 x 1200 dpi. max.

(Ink droplets can be placed with a pitch of 1/4800 inch at minimum)

Black printing
Draft: 6 ppm
Standard: 5.7 ppm
Color printing
Draft: 6 ppm
Standard: 4.2 ppm
Photo printing (PR-101 A4)
High (Fine): 0.98 ppm
Photo printing (PR-101 A3)
High (Fine): 0.55 ppm

322.2 mm max.(12.7 in)
(for borderless printing: 329.0 mm/13.0 in)

Canon Extended

80 KB

USB-Compatible

Approx. 37 dB (A) (in the best quality mode)

Temperature: 5 to 35°C (41 to 95°F)
Humidity: 10 to 90%RH (no condensation)

Temperature: 0 to 40°C (32 to 104°F)
Humidity: 5 to 95%RH (no condensation)

AC 100-127V, 50/60Hz
AC 220-240V, 50/60Hz

Standby: Approx. 3W
Printing: Approx. 24 W

573(W) x 334(D) x 196(H) mm
22.56(W) x 13.15(D) x 7.72(H) in

Approx. 8.0 kg (17.6 lb.)

Data format:
Canon extended mode: Raster image format

Resolution:
Canon extended mode: 600, 1200, 2400, 4800 dpi

512 nozzles of each color (1200 dpi)
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Printer
Ink Tanks:

Capacity (pages):

Black (BCI-6BK) approx. 590 *1, approx. 990 *2
Cyan (BCI-6C) approx. 860 *2

Magenta (BCI-6M) approx. 790 *2

Yellow (BCI-6Y) approx. 470 *2

Photo Cyan (BCI-6PC Photo) approx. 410 *2
Photo Magenta (BCI-6PM Photo) approx. 270 *2

*1 1500 characters per page, normal text, at standard and plain
paper mode with Windows XP

*2 Based on printing the 1SO JIS-SCID No.5 pattern at standard and
plain paper mode with Windows XP

BJ Printer Driver Systems Requirements
-

® Use a computer on which Windows XP, Windows 2000,
Windows Me or Windows 98 can operate.

® USB*interface

® Available hard-disk space for printer driver installation

Windows XP/Windows 2000: 50MB
Windows Me/Windows 98: 15MB

* USB operation can only be guaranteed on a PC with
preinstalled Windows XP, Windows 2000, Windows Me, or
Windows 98. (This includes Windows XP, Windows 2000 or
Wind)ows Me upgraded from pre-installed Windows 98 or
later

(Macintosh 8.6-9.x)

Use a Macintosh series computer equipped with USB
interface on which Mac OS 8.6-9.x can operate.
30MB of available hard-disk space for printer driver
installation.

(Macintosh 0S X)

Use a Macintosh series computer equipped with USB
interface on which Mac 0OS X v10.2.1 or later can operate.

100MB of available hard-disk space for printer driver
installation.

The following functions are not supported:

- Shared printer in the network (will be supported as an
0S function with Mac OS X v10.2 or later,

- Duplex Printing

- Photo Optimizer PRO

If you want to use an application, first install the
application contained in the Mac OS X folder.

Additional Systems Requirements for User's Guide

@ Pentium®, 75 MHz equivalent or higher processor (Pentium®, 133 MHz equivalent or higher processor recommended)

® 2xor higher CD-ROM drive (4x or higher recommended)
® 20 MB of available hard-disk space
® Microsoft Internet Explorer 5.0 or later
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A Safety Precautions

Please read the safety warnings and cautions provided in this manual to
ensure that you use your printer safely. Do not attempt to use the printer in
any way not described in this manual.

Warning  You may cause an electric shock/fire, or damage the printer if
you ignore any of these safety precautions.

Choosing a location

Do not place the printer close to flammable solvents such as alcohol or thinners.

Power supply

Never attempt to plug in or unplug the printer from the power supply when your hands are wet.

Always push the plug all the way into the power outlet.

Never damage, modify, stretch or excessively bend or twist the power cord.
Do not place heavy objects on the power cord.

Never plug the printer into a power socket that is shared with other
equipment (extension lead/cord, 2- or 3- way adapter, etc.).

Never use the printer if the power cord is bundled or knotted.

If you detect smoke, unusual smells or strange noises around the printer, immediately unplug the
printer at the power supply and call for service.

Periodically, unplug the printer and use a dry cloth to wipe off any dust or dirt
collected on the plug and the power outlet. If the printer is placed at a location
exposed to a lot of dust, smoke, or high humidity, the dust that collects on the
plug absorbs moisture and may cause insulation failure and fire.

Cleaning the printer

Use a damp cloth to clean the printer. Never use flammable solvents such
as alcohol, benzene or thinners.

If flammable solvents come in contact with electrical components inside the
printer, it could cause a fire or electric shock.

Always unplug the printer from the power outlet before cleaning the printer.

If you accidentally switch the printer on while cleaning it, you could injure yourself or damage the
printer.

Maintaining the printer

Dho not attempt to disassemble or modify the printer. There are no user serviceable parts inside
the printer.

The printer contains high-voltage components. Never attempt any maintenance procedure not
described in this guide.

Working around the
printer

Do not use flammable sprays near the printer.

This could cause a fire or electric shock if the spray comes into contact with the electrical
components inside the printer.
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Caution You may cause injury or damage the printer if you ignore any of
these safety precautions.

Choosing a location

Do not install the printer in a location that is unstable or subject to excessive vibration.

Do not install the printer in locations that are very humid or dusty, in direct sunlight, outdoors, or
close to a heating source.

To avoid the risk of fire or electric shocks, install the printer in a location with an ambient
temperature range of 5°C to 35°C (41°F to 95°F) and humidity of 10% to 90% (condensation free).

Do not place the printer on a thick rug or carpet.

Ensure that the area around the power outlet is kept clear at all times so you
can easily unplug the power cord if necessary.

When moving the printer, carry the printer by holding both sides.

Power supply

Never remove the plug by pulling on the cord.

Do not use an extension lead/ cord.

Never use a power supply voltage other than that supplied in the country of purchase.
The correct power supply voltage and frequency is as follows:

AC 100-127V, 50/60 Hz
AC 220-240V, 50/60 Hz

Working around the
printer

Never put your hands or fingers in the printer while it is printing.

Do not place metal objects (paper clips, staples, etc.) or containers of flammable solvents
(alcohol, thinners. etc.) on top of the printer.

Print heads and ink tanks

For safety reasons store print heads and ink tanks out of the reach of small children.
If a child ingests any ink, consult a doctor immediately.

Do not shake the print heads or ink tanks.
Ink may leak out and stain clothing or the surrounding area.

Never touch the electrical contacts on a print head after printing.
The metal parts may be very hot and could cause burns.
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Regulatory Information

Color Printer Model: K10210 (i9100)

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

¢ Reorient or relocate the receiving antenna.

¢ Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
e Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If such changes or
modifications should be made, you could be required to stop operation of the equipment.

Canon U.S.A,, Inc.
One Canon Plaza
Lake Success, NY 11042

Tel No. 1-516-328-5600

Canadian Radio Interference Regulations

This digital apparatus does not exceed Class B limits for radio noise emissions from a digital apparatus as set out in the
interference-causing equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe B
prescrites dans la norme sur le matériel brouilleur NMB-003 d'Industrie Canada intitulée « Appareils numériques ».
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Canon Printer and Scanner Limited Warranty --- (USA Only)

The limited warranty set forth below is given by Canon U.S.A., Inc. (“Canon USA”) with respect to the new or refurbished
Canon-brand printer or scanner (each a “Product”) packaged with this limited warranty, when purchased and used in the
United States only.

The Product is warranted against defects in materials and workmanship under normal use and service (a) for a period of one
(1) year from the date of original purchase when delivered to you in new condition in its original container or (b) for 90 days
from the date of original purchase for refurbished Products. Defective parts or a defective Product returned to a Canon USA
repair facility or a Canon USA Authorized Service Facility (“ASF”), and proven to be defective upon inspection, will be repaired,
exchanged for new or comparable rebuilt parts, or exchanged for a refurbished Product, as determined by the Canon USA
repair Facility or the ASF. Warranty repair or replacement shall not extend the original warranty period of the Product. This
warranty does not cover any accessories, or any consumables, such as paper or ink cartridges, as to which there shall be no
warranty or replacement.

This limited warranty shall only apply if the Product is used in conjunction with compatible computer equipment and software.
Canon shall have no responsibility for such items except for compatible Canon brand peripheral equipment covered by a
separate warranty (“Separate Warranty”). Repairs of such Canon brand peripheral equipment shall be governed by the terms
of the Separate Warranty. Non-Canon brand equipment and software that may be distributed with the Product are sold “as is”
and without warranty of any kind by Canon USA, including any implied warranty regarding merchantability or fitness for a
particular purpose, and all such warranties are disclaimed. The sole warranty, if any, with respect to such non-Canon brand
items is given by the manufacturer or producer thereof.

This limited warranty covers all defects encountered in normal use of the Product and does not apply in the following cases:

(@  Loss of or damage to the Product due to abuse, neglect, mishandling, improper packaging by you, alteration, accident,
electrical current fluctuations, improper use, failure to follow operating or maintenance instructions, or environmental
conditions prescribed in Canon USA’s user’s manual or other documentation, or services performed by someone other
than a Canon USA repair facility or its ASF. Without limiting the foregoing, dropping the Product, scratches, and
abrasions will be presumed to have resulted from misuse, abuse or failure to operate the Product as set forth in the
operating instructions.

(b)  Use of parts or supplies (other than those sold by Canon USA) that cause damage to the Product or cause abnormally
frequent service calls or service problems.

(c) If the Product has had it serial number or dating defaced, altered or removed.

ANY SYSTEM SOFTWARE (WHETHER FACTORY LOADED ON THE PRODUCT OR CONTAINED ON THE SOFTWARE DISKETTES OR CD-
ROM'S ENCLOSED WITH, OR ACCOMPANYING, THE PRODUCT), AND ANY UTILITY SOFTWARE, DISTRIBUTED WITH OR FOR THE
PRODUCT, IS SOLD "AS IS" AND WITHOUT WARRANTY BY CANON. THE SOLE WARRANTY WITH RESPECT TO SUCH SOFTWARE IS
CONTAINED IN THE SOFTWARE MANUFACTURER'S LICENSE AGREEMENT DISTRIBUTED THEREWITH, INCLUDING ANY LIMITATIONS
AND DISCLAIMERS THEREON. PLEASE CONTACT CANON IMMEDIATELY IF YOU HAVE NOT RECEIVED A COPY OF THE SOFTWARE
MANUFACTURER'S LICENSE AGREEMENT.

NO IMPLIED WARRANTY, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE,
APPLIES TO THE PRODUCT AFTER THE APPLICABLE PERIOD OF THE EXPRESS LIMITED WARRANTY STATED ABOVE, AND NO OTHER
EXPRESS WARRANTY OR GUARANTY, EXCEPT AS MENTIONED ABOVE, GIVEN BY ANY PERSON OR ENTITY WITH RESPECT TO THE
PRODUCT SHALL BIND CANON USA, OR ITS ASF. (SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED
WARRANTY LASTS, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.) CANON USA SHALL NOT BE LIABLE FOR LOSS OF
REVENUES OR PROFITS, INCONVENIENCE, EXPENSE FOR SUBSTITUTE EQUIPMENT OR SERVICE, STORAGE CHARGES, LOSS OR
CORRUPTION OF DATA, OR ANY OTHER SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES CAUSED BY THE USE, MISUSE, OR
INABILITY TO USE THE PRODUCT REGARDLESS OF THE LEGAL THEORY ON WHICH THE CLAIM IS BASED, AND EVEN IF CANON USA
OR ITS ASF HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY OF ANY KIND AGAINST CANON
USA OR ITS ASF BE GREATER IN AMOUNT THAN THE PURCHASE PRICE OF THE PRODUCT CAUSING THE ALLEGED DAMAGE.
WITHOUT LIMITING THE FOREGOING, YOU ASSUME ALL RISK AND LIABILITY FOR LOSS, DAMAGE OR INJURY TO YOU AND YOUR
PROPERTY AND TO OTHERS AND THEIR PROPERTY ARISING OUT OF THE POSSESSION, USE, MISUSE, OR INABILITY TO USE THE
PRODUCT SOLD BY CANON USA NOT CAUSED SOLELY AND DIRECTLY BY THE NEGLIGENCE OF CANON USA, OR ITS ASF. (SOME
STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE
EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU.) THIS LIMITED WARRANTY SHALL NOT EXTEND TO ANYONE OTHER THAN THE
ORIGINAL PURCHASER OF THE PRODUCT OR THE PERSON FOR WHOM IT WAS PURCHASED AS A GIFT, AND STATES YOUR
EXCLUSIVE REMEDY.
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Canon offers a full range of customer technical support* options:

. For interactive troubleshooting, e-mail technical support, the latest driver downloads and answers to frequently asked
questions (www.canontechsupport.com)

Automated interactive telephone support on most current products 24 hours, 7 days a week (1-800-423-2366)
24-hour, Fax-On-Demand System for product specifications and technical information (1-800-526-4345)

Free live technical support Monday—Saturday (excluding holidays) for products still under warranty (1-757-413-2848)
The location of the ASF nearest you (1-800-423-2366, select "automated support options")

If the problem cannot be corrected by using one of the above technical support options, repair options are available at the time
of your call to the Free live technical support number above or via the website at www.canontechsupport.com

This limited warranty gives you specific legal rights, and you may also have other rights, which vary from state to state.
* Support program specifics are subject to change without notice.

Canon U.S.A,, Inc.

One Canon Plaza

Lake Success, NY 11042
USA

Canon is a registered trademark of Canon Inc.
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